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Foreword

Gagelnterp was developed at the Hydrologic Engineering Center (HEC).
The program was written by Mr. Thomas A. Evans, and incorporates
functions written by Mr. William Charley, Mr. Paul Ely, and Mr. Carl
Franke. Functions for coordinate system and map projection
transformations were written at the US Geological Survey and distributed
with the PROJ4 software package.

Mr. Darryl Davis was director of HEC at the time that these programs
were written, and Mr. Arthur F. Pabst was chief of the technical
assistance division of HEC. In 2003, when the program was substantially
revised, Mr. Daniel Barcellos was chief of the water management
systems division of HEC.

Product and company names used in this manual are trademarks or
registered trademarks of their respective holders.

Mr. Thomas A. Evans wrote this manual.
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CHAPTER 1

Introduction

Gagelnterp creates a sequence of grids that approximate the variation
through space of a quantity measured varying through time at fixed
locations. It can be used to estimate spatially distributed values of
precipitation, temperature, or other parameters. The estimates are
generated at regular intervals of time for cells in the grid by reading
values from time-series data stored in HEC-DSS database files. Each
time series contains data for a single point, and Gagelnterp interpolates
values between and around those points, at the centers of cells in a grid.
The program writes the resulting grids to new records in one or more DSS
files. The user specifies the input gages as locations given by longitude,
latitude, optional elevation, and DSS path names from which the values at
the gages will be read, and also specifies the type and extent of the grid
to be used. The user can select an interpolation method from among
several options, and interpolated values may be adjusted by specifying a
bias grid, or by using a lapse computation on temperature measurements,
based on a user-supplied elevation grid.

1.1 How Gagelnterp Computes Cell Values

Gagelnterp computes its grid outputs cell-by-cell. The user specifies the
program’s operations through parameters written to a control file. These
parameters include a description of the grid’s geometry - its location,
extent and the size of its cells - and a list of the gages that provide its
input data. Each gage’s listing includes its location, specified as longitude
and latitude.

The program initializes by computing a distance from each cell in the grid
to each gage listed in the control file. For each cell, it compares the
distance from the cell center to each gage with a radius of influence that
gage. If the distance is greater than the gage’s radius, that gage will not
be used in estimating values at that cell. (The radius of influence can be
set for each gage, or globally. An individual gage’s radius takes
precedence over the global setting.)

At each time step, Gagelnterp queries the DSS records associated with
the gages. If the output data type is period cumulative (PER-CUM)
Gagelnterp reads a value for the interval between time steps. If the
output data type is instantaneous value (INST-VAL), Gagelnterp reads a
value at the time step. Unit conversions and some simple data screening
take place at this time. Negative values for precipitation are rejected, for
example. If bias or lapse adjustments (see Section 1.2) are in use,
adjusted values for each gage are calculated.

1-1
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After reading (and where applicable, adjusting) the gage values.
Gagelnterp estimates a value at each cell in the grid by calculating a
weighted average of all the values from gages that are not located farther
from the cell than their radius of influence. The averaging weights are
calculated according to one of the following methods, as specified in the
control file.

e Inverse distance squared (ID2W) — the default method. The
weighting factor for each gage is equal to one divided by the
square of the distance from the cell to the gage.

¢ Inverse distance (IDW). The weighting factor for each gage is
equal to one divided by the distance from the cell to the gage.

o Nearest gage (NEAR). The nearest gage with a valid value gets a
weight of one; all other gages get a weight of zero.

e Average (AVER). All gages get a weight of one.

Gage 18|

j\\

/ \\ Gage 4

Gage|2

Gage 3

Figure 1.1 Gages Influencing a Cell

An additional computation may adjust the value at the cell by applying a
bias factor or by introducing a lapse computation. These adjustments are
described in the following section.

1.2 Lapse and Bias Computations

Gagelnterp supports the use of a value adjustment grid to shape the
distribution of interpolated values. For air temperature interpolations, the
adjustment is computed as lapse, based on the elevation of the cell and
the elevations of the gages that contribute to its interpolated value. For
all other computations, the adjustment is a bias by a scaling factor.
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The bias method adjusts interpolated values as follows. Each gage’s
coordinates locate the gage within a cell in the bias grid. The value of
that cell is assigned to the gage as a bias factor. For each time step, the
value from the gage is divided by the gage’s bias factor to produce an
adjusted value for the gage. The adjusted values are then interpolated
over the grid to produce an intermediate result grid. The values in the
cells of the intermediate result grid are multiplied by the values in the
corresponding cells of the bias grid to produce the output grid.

Lapse adjustments to temperature values are made as follows. The
elevation of each gage is multiplied by the lapse rate, and the product is
subtracted from each gage’s temperature value, resulting in an estimated
sea-level temperature for each gage. The adjusted gage temperatures
are interpolated over the grid by the selected interpolation method to
produce an intermediate grid of sea-level temperatures. For each cell in
the output grid, a final temperature is calculated by adding the product of
the lapse rate and the cell’s elevation to the sea-level temperature for that
cell.

The lapse rate can be set in three ways. A fixed value can be used for a
run, a time series can be used to provide a changing rate over the course
of a run or the lapse rate can be estimated at each time step based on
reported temperatures at the gages. The fixed lapse rate defaults to a
value of -0.0065 degrees Celsius per meter of elevation if no user-
specified value is provided in the configuration file.

For estimating a variable lapse rate, Gagelnterp calculates a linear
regression of temperature vs. elevation at all the gages at each time step.
The lapse rate is equal to the slope of the estimated regression line. This
method allows Gagelnterp to detect changes in the lapse rate, including
temperature inversions, which may be very important for snow modeling
and other applications of temperature grids. The use of linear regression
to estimate the lapse rate, however, makes this method very sensitive to
errors in the temperature data, since errors can affect both the values
interpolated directly from them, and the lapse rate. The recalculation at
every time step means that new opportunities for errors to exert this
strong influence occur over and over during the course of a Gagelnterp
run. Temperature data should be screened carefully before this method
is used.

1-3
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CHAPTER 2

Requirements and Setup

2.1

2.2

Installation for Windows

The Gagelnterp distribution package for Windows included the
executable gageInterp. exe and the supplemental data file
conus.nad. The gageInterp.exe program should be installed in a
directory named on your system path (C: \ hecexe, if possible). The file
conus.nad is required to support geographic coordinate transformations.
By default, Gagelnterp will look for conus.nadin C: \hecexe\sup orin
the directory named by the environment variable PROJ LIB.

Installation for Sun UNIX

The Gagelnterp distribution package for Sun workstations includes the
executable gageInterp and the supplemental data file conus. nad.
The executable should be installed in a directory named in your path
(/usr/hec/bin, if possible). The file conus. nadis required to support
geographic coordinate transformations. By default, Gagelnterp looks for
conus.nad in the directory /usr/hec/sup or in the directory named by
the environment variable PROJ LIB.

To install Gagelnterp, copy the executable to /usr/hec/bin and copy
conus.nadto /usr/hec/sup. If you can’t put conus.nadin
/usr/hec/sup, copy it to any directory you like and then set the
environment variable PROJ LIB to that directory name with the
command:

setenv PROJ LIB /mydirectory/mysub

substituting the path on your system for /mydirectory/mysub. Add
this command to the . cshrc or other shell initialization files of users who
will be running Gagelnterp. Make sure that users of the program have
execute permission for gageInterp and read permission for
conus.nad.

2-1
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CHAPTER 3

Operating Instructions

To interpolate gaged time-series values onto a grid, it is necessary to
specify the locations of the gages, identify the DSS data records
associated with those gages, specify the output grid (cell spacing, grid
origin, number of rows and columns, units and data type), and choose a
start time, end time, and time step for the interpolation.

Note that, although the time-series data associated with gages can be in
any time zone, Gagelnterp always writes grids with a time stamps in
Universal Coordinated Time (UTC). The start and end times for
computations are likewise in UTC.

Gagelnterp is controlled by items entered on the command line, and by
data read from a control file. Some control data can be entered either on
the command line or in the control file; values entered on the command
line always take precedence over those in the control file so that a single
control file can be used for multiple runs in scripts or batch processes.

3.1 Command Line Parameters

The program is invoked with the following command:

gageInterp CONTROL=confile [SDATE=startDate]
[STIME=startTime] [EDATE=endDate] [ETIME=endTime]
[DSSIN=Filename] [DSSOUT=Filename] [VERBOSE=level]

where:

CONTROL = specifies the name of the Gagelnterp control file
SDATE = specifies the starting date of the computation interval
STIME = specifies the starting time of the computation interval
EDATE = specifies the ending date of the computation interval
ETIME = specifies the ending time of the computation interval
DSSIN = specifies a file from which all DSS inputs will be read
DSSOUT = specifies a file to which grid records will be written
VERBOSE = controls the messages written to standard output

The control file name must be given on the command line. All other
command-line arguments are optional, although some must be specified
in the control file if not given on the command line. See the next section
for a description of the control file.

3-1
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All argument labels can be abbreviated as long as enough characters
remain to make the label unique. For example, SD and ED are sufficient
to specify the start and end dates.

The arguments SDATE, STIME, EDATE, and ETIME specify the start and
end of the period for which interpolations will be calculated. Dates and
times should be given in military style, for example:

SDATE=06JUN1944 STIME=1500

Although dates for the start and end of the interpolation period are
optional on the command line, they must be provided in the control file if
they are not given on the command line. If no dates are provided, the
program will produce an error message and exit. If dates are provided on
the command line with no associated times, the program will run from the
beginning of the starting date to the end of the ending date, regardless of
the times specified in the control file. For example, the command:

gageInterp CON=con.ginterp SD=14JAN95 ED=14JAN95
will produce interpolated values for the entire day of January 14, 1995.

Start and end times are assumed to be in UTC, whether given in the
control file or on the command line. To interpolate grids for 14 January
1995 in the Eastern Time Zone of the United States, the program would
be invoked as:

gagelInterp SDATE=14JAN95 STIME=0500 EDATE=15JAN95
ETIME = 0500

The command line arguments DSSIN and DSSOUT override the values
for input and output DSS files given in the control file. This is helpful for
scripted applications, where new input and output files can be named for
different times, model applications, etc.

The VERBOSE argument controls the amount of output written to
standard out. The verbose level is a number from zero and five. A
verbose level of zero suppresses most output except a short summary of
each grid as it is written. A verbose level of five echoes the content of the
control file and gives detailed descriptions of each gage reading for each
time step. The default level is two.

Control File Parameters

Most of Gagelnterp's operations are controlled by parameter values set in
the control file. Comment lines in the control file begin with an asterisk (*)
and have no effect on program operation. Blank lines are ignored as well.
Lines that set operating parameters begin with a keyword, followed by a
colon and a parameter value or set of values. Where multiple parameter
values appear on a line, they can be separated by any combination of
spaces, tabs, and commas. For example, the lines:
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* Peak intensity period for January Storm
TimeStart: 13JANS5, 1300
TimeEnd: 13JAN95, 1400

set the start and end times for the interpolation period. The first line is a
comment, written by the user to identify the purpose of the file; the next
two lines start with the keywords TimeStart and TimeEnd, respectively,
and each line contains two parameter values (a date and a time)
separated by a comma and a space.

The control file contains three sections. The first section sets parameters
that control the interpolation process: the start and end times, the
interpolation method to be used, the maximum distance a gage can be
from a cell to contribute to its precipitation estimate and the output DSS
file and path names. The second section sets output grid parameters: the
type of grid, its location, and the number of cells (rows and columns) it will
contain. The third section sets precipitation gage parameters: their
names, locations, and the DSS file and path names associated with them.

3.2.1 Interpolation Parameters
The following information is required to control the interpolation process:

e Start and end times in UTC
e Interpolation method
e Maximum cell-to-gage distance

The control file must contain lines setting the DSS file and path names for
output of the interpolated precipitation. Start and end times for the
interpolation must be provided either in the control file or on the command
line when the program is started. Table 3.1 shows the keywords used to
set these parameters.

Additional notes on setting interpolation parameters in the control file:

¢ Start and end times require a date, and may include a time.

¢ The time step of the grids defaults to one hour, but can be set to
other values in the control file.

¢ The interpolation method will default to inverse-distance-squared
weighting if it is not specified in the control file.

o If a value is specified for the range, only gages located within that
distance (in meters) of a cell will be included in estimates at that

cell. If no range value is specified, the range defaults to 30,000

meters (thirty kilometers). Specifying UNLIMITED for the range
will cause all gages to be included in estimates for all cells.

¢ The range can be overridden for individual gages. See discussion
of the RADIUS parameter in Section 3.2.2.
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Table 3.1 Interpolation Parameters in Gagelnterp Control File

Keyword

Function

Values

* (asterisk)

Identifies comment
line.

ENDFILE Lines following this
keyword will be
ignored.

TimeStart Sets beginning time Valid HECT ime strings for date and
of first interpolation time Example: 13JAN1995, 1100
interval

TimeEnd Sets ending time of Valid HECTime strings for date and
last interpolation time
interval

TimeStep Sets length of grid Numerical values in minutes.
time interval Acceptable values are limited to 1,

5, 10, 15, 20, 30, 60, 120, 180, 240,
360, 480, 720, 1440. Defaults to 60
minutes.

Weight Sets interpolation ID2W inverse distance squared
method (default)

IDW inverse distance

NEAR nearest gage (Theissen
polygon)

AVG average of all gages in range

Range Sets maximum Numerical Value in meters.
distance between cell | Defaults to 30,000 meters. If a
center and gage value of UNLIMITED is entered, all
contributing to cell gages will be included in estimates
precipitation estimate | at all cells.

AdjustMethod Sets the adjustment | BIAS can be used for most data

method (BIAS or
LAPSE) to be applied
to the output grids

types, including precipitation.
LAPSE can be used for
temperatures only.

AdjustGridFile

DSS file containing
the bias or elevation
grid

DSS filename.

AdjustGridPath Identifies DSS grid DSS pathname. Any values in BIAS
record containing grids are acceptable. Elevation
bias factors or grids must be in meters.
elevations for lapse
LapseMethod Sets method for FIXED, TIMESERIES, or
calculating lapse rate | CALCULATED
LapseRate Sets constant lapse Lapse rate in degrees C per m.

rate

Default value is -0.0065.

LapseRateFile

Sets name of DSS
file containing a time
series of lapse rates

Name of existing DSS file
containing the lapse rate time
series.

LapseRatePath

Sets the path of the
DSS record
containing a time
series of lapse rates.

Path name of an existing time series
record containing lapse rates
expressed in degrees F/FT or
degrees C/m

34
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3.2.2

Grid Parameters

The output grid must be specified with the following information: the type
of grid, the location of the grid origin, and the number of rows and
columns in the grid, the name of the DSS file to which the grid will be
written, and the DSS path that will be used to identify the grid records.
The grid type can be set to HRAP (the grid specified by the National
Weather Service’s Hydrologic Rainfall Analysis Project and used for
distribution of the NEXRAD radar precipitation data) SHG (the Standard
Hydrologic Grid, defined by HEC) or an SHG-like grid system based on
UTM coordinates in the specified zone (see Appendix F). The grid’s
origin (its southwest or “lower left” corner) and the number of rows and
columns can be specified directly or indirectly by identifying minimum and
maximum longitude and latitude to be covered by the grid. Table 3.2 lists
the keywords used to set these parameters.

Table 3.2 Interpolation Grid Parameters in Gagelnterp Control File

Keyword Function Values
GridType Sets output grid type | HRAP (default)
SHG or UTM (with Zone ID)
CellSize Sets size of SHG Cell size in meters. Only values of
cells 10, 20, 50, 100, 200, 500, 1000,
2000, 5000, or 10000 are allowable.
GridOrigin Sets origin of grid Coordinate Pair given as HRAP,
SHG, or UTM cell numbers
GridRows Number of rows in Integer
grid
GridCols Number of columns Integer
in grid
GridBounds Bounding Two coordinate pairs as longitude,
coordinates of grid latitude.
OutUnits Sets units on output | Optional. Default value is mm. Any
grids unit supported by DSS. (mm or
INCHES for precipitation; DEG C or
DEG F for temperature)
OutDataType Sets DSS data type Defaults to PER-CUM. Use INST-
for output grids VAL for temperature grids.
OutParameter | Identifies data type Default value is precip. Will be set to
for unit conversions. | air temperature if units are DEG C
or DEG F.
OutFile Names DSS file for Existing DSS file name or new
output filename
OutPath Names DSS path for | Valid DSS path name (D and E
output parts can be blank)
/BAS/LOC/PRECIP///GRIDDED/

Additional notes on setting grid parameters in the control file:

e UTM zone ID is specified as a number (1-60) followed by an ‘N’ or
‘S’ to indicate northern or southern hemisphere. “UTM 17N”
means zone 17 in the northern hemisphere. “UTM 59S” means
zone 59 in the southern hemisphere.

3-5
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¢ Use only one method to specify the grid origin and size. The first
setting of an origin or size of the grid is the only one that will be
accepted. Once a grid origin, row or column count is specified,
any attempt to redefine it will be rejected.

¢ Longitude and latitude for GridBounds can be entered in any of
the following formats:

Decimal degrees, negative for west longitude or south latitude
(e.g. -91.5050)

Decimal degrees, NSEW suffix for hemisphere (e.g.
91.5050W)

Integer ddmmss, negative for west longitude and south latitude
(e.g.-913018)

Delimited degrees minutes seconds, can include decimal
seconds (e.g. 91d30'18.0"W)

Delimited degrees minutes, can include decimal minutes (e.g.
91d30.3'W)

¢ GridBounds coordinate pairs should be entered as longitude,
latitude, longitude, latitude. The entry “91.0W, 38.0N, 90.0W,
39.0N” for example, specifies a one-degree quadrangle enclosing
St. Louis, Missouri.

¢ The output DSS file name can be specified by a file name alone,
or by a file system path and file name.

e Prior to Version 3.0, HMS assumes that all precipitation grid data
is in millimeters. If you are making precipitation grids as input to
HMS, check your version number and use the default units of mm
where appropriate.

¢ For most applications, the OutParameter setting can be left out
of the control file. This parameter serves two purposes: it forms
part of automatically generated output file names (see Appendix
A, Using Gagelnterp in CWMS) and it affects unit conversions. If
the OutParameter value is set to precip (the default value) or
airtemp, gagelnterp will convert the units of input data to match
the output units given in the control file. If this parameter is set to
any other value, gagelnterp will not perform any unit conversions,
and the user must make sure that the input time series data are
all in the same units as the output grids.

3.2.3 Gage Parameters

For each gage included in the interpolation, the following data must be
provided: the gage’s location in longitude and latitude, the name of the
DSS file containing the precipitation records for that gage, and the DSS
path name associated with those precipitation records. In addition, the
geographic datum used for the definition of the longitude and latitude can
be specified. Table 3.3 lists the keywords used to set these parameters.
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Table 3.3 Gage Parameters in Gagelnterp Control File

Keyword Function Values
DSSFile Names a DSS file. [Index =] Name of existing DSS file.
Optionally provides Examples:
an index for the DSS | /home/data/river.dss
file. 1=/home/data/river.dss
Gage Specifies name, String, Coordinate Pair, elevation in
location, and meters. Elevation is optional and used
elevation of a gage only for lapse computations.
WEBB 95d10'06W 35d35'12
Path Specifies DSS path [Index:] Valid DSS path name with
name for gage optional D and E parts.
Examples:
//LOC/PRECIP-CUM//IR-
MONTH/OBS/
1:/BASIN/LOC/PRECIP-CUM///OBS/
Timezone Specifies the time Three-letter time zone ID, Y or N
zone for the (indicating whether daylight saving
precipitation time time is observed.)
series, determining ESTN
an offset time from
uTcC
Radius Sets maximum Numerical Value in meters. Defaults
distance between this | to value of the Range parameter.
gage and cells to
which it will
contribute. Overrides
the global Range
parameter.

Disable Disables a gage No value. Ifadisable: lineis
present in a gage block, the gage is
ignored.

Text Label information for | Character string. Can extend over

gage. more than one line.

Datum Geographic datum for | NAD27 (default for HRAP and SHG)

coordinates of gage NAD83
location WGS84 (default for UTM)

Additional notes on setting gage parameters in the control file:

¢ A gage must be named before any descriptors can be associated
with it. Gage data should be entered with the gage line first,
followed in any order by a path line, a time zone line, and optional
disable, datum, and text lines.

¢ Coordinates for gage locations can be given in the same formats
as the grid limits.

¢ At least one DSS input file must be specified with a DSSFile line.
If more than one DSS file is to be used, each must be identified
with an index. If only one DSS file is used, an index can be used,
but is not required. If one un-indexed DSS file is named, path
names must not include indices. If indexed DSS files are used,
the first path name listed must include a file index; after the first
path is named, any following path without an associated index
will be associated with the last index used.
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o If the E part of a gage’s DSS path is omitted and the output is of
type PER-CUM, Gagelnterp will look for an E part that matches
the output time step. If the output type is INST-VAL, an E part
must be specified.

e Text lines are ignored. They are included as optional entries in
the control file so that users can copy gage data directly between
control files for Gagelnterp and the SVT spatial data visualization
program.

e For HRAP and SHG grids, if a gage’s definition in the control file
does not contain a DATUM line, its longitude and latitude will be
assumed to be in NAD27 coordinates.

e For UTM grids, if a gage’s definition in the control file does not
contain a DATUM line, its longitude and latitude will be assumed
to be in WGS84 coordinates.

o NAD27 and NAD83 are not defined outside the US. In UTM grids,
if a gage outside the US is given a NAD27 datum, its location will
be undefined and the gage will be disabled. NAD83 coordinates
will be assumed to be identical to WGS84 coordinates for UTM
grids.

¢ Valid time zone codes are listed in Table 3.4. For each gage the
user must specify a time zone and whether daylight savings time
is observed.

Table 3.4 Time Zone Labels and Offsets (in Minutes) from UTC

Std DST
ID Zone Name Offset Offset

HST Hawaii-Aleutian -600 -600
AST Alaska -540 -480
PST Pacific -480 -420
PNT Phoenix -420 -420
MST Mountain -420 -360
CST Central -360 -300
EST Eastern -300 -240
IET Indiana Eastern -300 -300
PRT Puerto Rico/Virgin Islands -240 -240
CNT Canada Newfoundland -210 -150
GMT Greenwich Mean 0 60

Using Bias and Lapse Adjustments

To adjust grid values using scale biasing, the user sets the
AdjustMethod parameter equal to BIAS in the control file and names a
DSS gridded record to be used for scaling. The bias grid is named by
specifying a DSS file name with the AdjustGridFile parameter, and a
path name with the AdjustGridPath parameter. The extent of the
adjustment grid must be large enough to include the full extent of the
output grid and the locations of all the gages used in the interpolations.

In the example below, a month’s average precipitation as estimated by
the PRISM model is used as a source of bias factors for precipitation
estimates
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* Use bias grid to adjust precipitation values
AdjustMethod: BIAS

AdjustGridFile: rogueGrid.dss

AdjustGridPath: /SHG/ROGUE/PRECIP-AVER/O01DEC/31DEC//

To adjust temperature grid values with a lapse rate, the user must set the
AdjustMethod parameter equal to Lapse and use the
AdjustGridFile and AdjustGridPath parameters to name a DSS
gridded record containing elevations for the cells in the output grid.
Elevations for gages can be specified on the gage lines in the control file.
If the elevation of a gage is not given in the control file, Gagelnterp will
read it from the elevation grid. The lapse rate can be set to a constant
value or estimated by linear regression from the temperatures and
elevations of the gages at each time step.

In the example below, temperatures are adjusted by a constant lapse rate
of -0.0069 degrees Celsius per meter elevation. The negative value
indicates that temperature will decrease with increasing elevation.

* Use fixed lapse rate to adjust temperatures
AdjustMethod: Lapse

LapseMethod: Fixed

LapseRate: -0.0069

AdjustGridFile: rogueGrid.dss

AdjustGridPath: /shg/rogue/elevation///ned-med/

If the LapseRate parameter is omitted when the LapseMethod is set to
Fixed, the lapse rate will default to -0.0065 degrees Celsius per meter of
elevation.

In the example below, temperatures will be adjusted by a lapse rate that
changes with each time step, based on the temperatures reported at each

gage.

* Use variable lapse rate to adjust temperatures
AdjustMethod: Lapse

LapseMethod: Calculate

AdjustGridFile: rogueGrid.dss

AdjustGridPath: /shg/rogue/elevation///ned-med/

In the examples, the elevation grids are derived from the National
Elevation Dataset (NED). The procedures that were used for making
these grids and loading them into DSS are described in Appendix Q.

3.4 Run-Time Messages

Gagelnterp prints status messages to both standard output (the terminal,
or a file, if output is redirected) and standard error (also the terminal).

The amount of status information is controlled by the VERBOSE option on
the command line. The messages to standard output can include a list of
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the gages used in the interpolation, summaries of the interpolated
precipitation grids, warnings of negative, unreadable, or missing
precipitation values at the gages, and warnings of missing or non-
standard units in the precipitation data files. The warnings of negative,
unreadable, or missing precipitation values and non-standard units are
also sent to standard error, so these will appear twice if both standard out
and standard error are directed to the terminal. Samples of run-time
output are shown in Appendix B.

Interpolation Results

The results of the interpolation are written to the specified DSS file and
path name as DSS grid data records. Grids in this format can be used as
input to HEC-HMS and can be visualized with GridUtil. The program can
also be used to generate precipitation and temperature inputs for the
distributed snow process model (DSPM).

HEC has established the following naming convention for DSS grid
records:

e A Part = Grid System (HRAP, SHG, and UTM are currently
supported, see Appendix R for grid system definitions)

¢ B Part = Name of the region the grid represents

e C Part = The parameter represented by the grid (PRECIP,
AIRTEMP, etc.)

¢ D and E Parts = Grid times (see explanation below)

e F Part = Version identifier.

Because each grid record represents a single instant or interval of time,
the D and E parts of grid pathnames follow a different convention than the
one for time series pathnames. For period cumulative (PER-CUM) grids,
the D part contains the start date and time of the period and the E part
contains the end date and time. For instantaneous (INST-VAL) grids, the
D part contains the date and time of the grid values and the E part is
blank. Dates and times are given in military style with date separated
from time of day by a colon. Grid times should always be given in
Universal Coordinated Time (UTC). For example, an instantaneous grid
with a D part of 04JUL2001:1500 represents values at 3:00pm UTC
(8:00am Pacific Daylight Time) on July 4, 2001.

e /SHG/ROGUE/PRECIP/02JUN2003:0800/02JUN2003:0900/
GAGEINTERP/ identifies precipitation on the SHG grid over the
Rogue River basin generated by Gagelnterp
e /HRAP/ABRFC/PRECIP/02JUN2003:0800/
02JUN2003:0900/MPE/ identifies precipitation on the HRAP grid
loaded from an NWS multi-sensor precipitation estimate product
from the Arkansas-Red Basin River Forecast Center
e /SHG/FEATHER/AIRTEMP/11DEC2003:0700//LAPSE/
identifies air temperature over the Feather River basin generated
by Gagelnterp using a lapse adjustment.
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Interpolated precipitation values will typically show less variation than
radar data. Interpolated values will always lie between the minimum and
maximum gage values, and the highest and lowest precipitation
intensities will appear to coincide with gage locations. If the maximum
range option is used in the interpolation, there may be gaps in the
precipitation data over the grid. If no gages are present within range to
contribute to the precipitation estimate at a cell, that cell will be assigned
a "no data" value. Malfunctioning or non-reporting gages may cause
large areas in a grid to show "no data."

Figure 3.1 Radar (1) and interpolated (r) grids
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Appendix A

Sample Control Files

A1 SHG Sample

This file is configured for coverage of the lllinois River basin upstream of
Tenkiller Dam. The basin is covered by two-kilometer cells in the
Standard Hydrologic Grid (SHG). In this example all the gage data is
read from a single DSS file named "in.dss", and all gages are used in the
interpolation for each cell (that is, the interpolation range is unlimited).

* gagelnterp control file for Illinois River
(Oklahoma)

* January 1995 storm event, peak intensity period
TimeStart: 13JAN95, 0000

TimeEnd: 14JANS5, 0600

OQutFile: illgrids.dss
OutPath: /SHG/ILLINOIS/PRECIP///INTERPOLATED/

* Use inverse-distance-square weighted average for
interpolation
weight: id2w

* Include all gages in interpolation
range: UNLIMITED

*SHG region defined with geographic coordinates
GridType: SHG
CellSize: 2000
GridBounds: -95.1342 35.5621 -94.0459 36.4595

**PRECIPITATION GAGES

DSSFile: in.dss

gage: DUTC, -942911, 355248

path: /ILLINOIS/DUTC/PRECIP-CUM///OBS
timezone: CST, Y

gage: Gore, 95d04'07wW, 35d34'23N

path: /ILLINOIS/GORE/PRECIP-CUM///OBS
timezone: CST, Y
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gage: Eldon, 94450'18w, 35d55"16N
path: /ILLINOIS/ELDN/PRECIP-CUM///OBS
timezone: CST, Y

Remaining gage identifiers omitted

HRAP Sample

This file is configured for coverage of the lllinois River basin upstream of
Tenkiller Dam. The basin is covered by cells in the Hydrologic Rainfall
Analysis Project (HRAP) grid. In this example, the gage data is read from
three separate DSS files, and gages must be within 25-kilometers of a
cell to be included in the interpolation calculations for the value in that
cell, except for the gage at Eldon, which has an extended radius of
influence.

* gagelnterp control file for Illinois River
(Oklahoma)

* January 1995 storm event, peak intensity period
TimeStart: 13JAN1995, 0400

TimeEnd: 15JAN1995, 0800

OQutFile: illgrids.dss
OutPath: /HRAP/ILLINOIS/PRECIP///INTERPOLATED/

* Use inverse-distance-square weighted average for
interpolation
weight: id2w

* Include gages within 25km of cell in interpolation
range: 25000

* HRAP grid specified with geographic coordinates
*GridType: HRAP
*GridBounds: -94.939 36.459 -94.249 35.468

* Same HRAP grid specified by cells
GridType: HRAP

GridOrigin: 621, 334

GridRows: 21

GridCols: 30

* Precipitation Gages
DSSFile: 1l=grand.dss

DSSFile: 2=arkansas.dss
DSSFile: 3=illinois.dss
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* note: no spaces in gage name (lon and lat in
ddmmss)

gage: Ft Gibson, -961345, 355115

timezone: CST, N

path: 1:/GRAND/FGIB/PRECIP-INC///OBS/

* (lon and lat in decimal degrees)

gage: Lake Hudson, -95.1933, 36.2317

timezone: CST, N

*This gage uses the same DSS file as the last gage
path: /GRAND/HUDS/PRECIP-INC///OBS/

* (lon and lat in delimited degrees, minutes,
seconds)

gage: Tiff City, 94d35'12W, 36d37'50N
timezone: CST, N

path: /GRAND/TIFF/PRECIP-INC///OBS/

gage: Gore, 95d04'07w, 35d24'23N
path: 3:/ILLINOIS/GORE/PRECIP-INC///OBS/
timezone: CST, N

*This gage has an extended radius and will
* affect cells up to 40km away

gage: Eldon, 94d50'18W, 35d55'l6N
timezone: CST, N

radius: 40000

path: /ILLINOIS/ELDN/PRECIP-INC///OBS/

* NAD83 coordinates for this gage
gage: Kansas, 94d42'31w, 36d01'54N
timezone: CST, N

path: /ILLINOIS/KANS/PRECIP-INC///OBS/
Datum: NADS83

gage: Tenkiller, 95d02'57w, 35d33'48N
path: /ILLINOIS/TENK/PRECIP-INC///OBS/
timezone: CST, N

gage: Tahlequah, 94d55'15wW, 35d55'17N
timezone: CST, N
path: /ILLINOIS/TAHL/PRECIP-INC///OBS/

gage: Watts, 94d34'12w, 36d07'48N
timezone: CST, N
path: /ILLINOIS/WATT/PRECIP-INC///OBS/

gage: Dutch Mills, 94d29'11w, 35d52'48N
path: /ILLINOIS/DUTC/PRECIP-INC///OBS/
timezone: CST, N
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gage: Muskogee, 95d17'55W, 35d46'10N
path: 2:/ARKANSAS/MUSK/PRECIP-INC///OBS
timezone: CST, N

gage: Webber's Falls, 95d10'0Oo6wW, 35d35'12N
path: /ARKANSAS/WEBB/PRECIP-INC///OBS/
timezone: CST, N

A3 UTM Sample

This file is configured for coverage of the Russian River basin in norther
California. The basin is covered by cells defined in UTM coordinates.

* gageInterp for Russian River basin

*TimeStart: 15DEC2005, 0000
TimeStart: 16DEC2005, 0000
*TimeEnd: 17DEC2005, 2400
TimeEnd: 06JAN2006, 2400
TimeStep: 60

GridType: UTM 10N
CellSize: 2000

GRIDBOUNDS: -123d30'21.7", 39d427'27.7", -
122d427'3.5", 38d11'32.8"

Outfile: precip.DEC05.dss
OutPath: /UTM10N/Russian/precip///INTERPOLATED/

DSSFile: RussianRainGages.dss

*Ukiah adjustment to be used for run DEC2005
gage: UKIAH CA US, -123.2, 39.15

path: //UKIAH CA US/PRECIP-
INC/01DEC1964/1HOUR/DISTRIBUTED/

timezone: PST, N

Datum: NADS83

*Cloverdale adjustment to be used for run DEC2005
gage: CLOVERDALE CA US, -122.98333, 38.76667
path: //CLOVERDALE CA US/PRECIP-
INC/01DEC1964/1HOUR/DISTRIBUTED/

timezone: PST, N

Datum: NAD83
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*Healdsburg adjustment to be used for run DEC2005
gage: HEALDSBURG CA US, -122.83333, 38.61667
path: //HEALDSBURG CA US/PRECIP-
INC/01DEC1964/1HOUR/DISTRIBUTED/

timezone: PST, N

Datum: NADS83

*Santa Rosa adjustment to be used for run DEC2005
gage: SANTA ROSA CA US, -122.7, 38.45

path: //SANTA ROSA CA US/PRECIP-
INC/01DEC1964/1HOUR/DISTRIBUTED/

timezone: PST, N

Datum: NAD83

Gage: ANGWIN PAC UNION COL, -122.43333, 38.56667
Path: //ANGWIN PAC UNION COL/PRECIP-
INC/01NOV1967/IR-MONTH/040212/

TimeZone: PST, N

Gage: CLEARLAKE 4 SE, -122.63333, 38.96667
Path: //CLEARLAKE 4 SE/PRECIP-INC/010CT1954/IR-
MONTH/041806/

TimeZone: PST, N

Gage: CLOVERDALE 1 S, -123, 38.8

Path: //CLOVERDALE 1 S/PRECIP-INC/01FEB1973/IR-
MONTH/041839/

TimeZone: PST, N

Gage: CLOVERDALE 11 W, -123.21667, 38.76667
Path: //CLOVERDALE 11 W/PRECIP-INC/01JAN1950/IR-
MONTH/041840/

TimeZone: PST, N

radius: 50000

Gage: HOPLAND 8 NE, -123, 39.01667

Path: //HOPLAND 8 NE/PRECIP-INC/01JAN1950/IR-
MONTH/ 044097/

TimeZone: PST, N

Gage: MAHNKE, -122.78333, 38.85
Path: //MAHNKE/PRECIP-INC/01JAN1956/IR-MONTH/045258/
TimeZone: PST, N
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Appendix B

Sample Run-Time Messages

B.1 Standard Out

Run time: 26 June 2001, 09:18
*x*x*xx Control File: shg.ctl ****xx*

————— DSS---ZOPEN: Existing File Opened, File: in.dss
Unit: 71; DSS Versions - Software: 6-KG,
12 gages registered with interpolation grid.

Interpolation grid has 2550 cell(s).
6-1J
————— DSS---ZOPEN: Existing File Opened, File: illgrids.dss
Unit: 72; DSS Versions - Software: 6-KG,

Period from 13 January 1995, 00:00 to 13 January 1995, 01:00 UTC

=- Period ending 13 January 1995, 01:00 UTC: All gages reporting data.
=- Grid ILLINOIS (2550 cells). Cell values (mm): min: 0.00 mean: 0.00
max: 0.00

=- Cell Counts: null: 0; =0: 2550; >0: 0; >=3: 0; >=12: 0; >=25: 0

Period from 13 January 1995, 01:00 to 13 January 1995, 02:00 UTC
Missing data: /GRAND/HUDS/PRECIP-CUM//1HOUR/OBS/

=- Period ending 13 January 1995, 02:00 UTC: 1 of 12 gages missing data.
=- Grid ILLINOIS (2550 cells). Cell values (mm): min: 0.00 mean: 0.00
max: 0.00

=- Cell Counts: null: 0; =0: 2550; >0: 0; >=3: 0; >=12: 0; >=25: 0

27 precipitation reports omitted

Period from 14 January 1995, 05:00 to 14 January 1995, 06:00 UTC
Missing data: /GRAND/HUDS/PRECIP-CUM//1HOUR/OBS/

Missing data: /GRAND/TIFF/PRECIP-CUM//1HOUR/OBS/

=- Period ending 14 January 1995, 06:00 UTC: 2 of 12 gages missing data.
=- Grid ILLINOIS (2550 cells). Cell values (mm): min: 0.01 mean: 1.53
max: 2.98

=- Cell Counts: null: 0; =0: 0; >0: 2550; >=3: 0; >=12: 0; >=25: 0

Grid: ILLINOIS from 13 January 1995, 00:00 to 14 January 1995, 06:00 UTC
Values: max of max: 12.59 min of min: 0.00 mean of mean: 1.62

6-KG

————— DSS---ZCLOSE Unit: 71, File: in.dss
Pointer Utilization: 0.04
Number of Records: 72
File Size: 2679.8 Kbytes
Percent Inactive: 79.4

————— DSS---ZCLOSE Unit: 72, File: illgrids.dss
Pointer Utilization: 0.41
Number of Records: 182
File Size: 510.4 Kbytes
Percent Inactive: 42.2
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B.2

Standard Error

Standard Error:

Negative Precip reported
from 13 January 1995,
Negative Precip reported
from 13 January 1995,
Negative Precip reported
from 13 January 1995,

for path
04:00 to
for path
08:00 to
for path
12:00 to

/ILLINOIS/TAHL/PRECIP-CUM//1HOUR/OBS/
13 January 1995, 05:00.
/ILLINOIS/TAHL/PRECIP-CUM//1HOUR/OBS/
13 January 1995, 09:00.
/ILLINOIS/TAHL/PRECIP-CUM//1HOUR/OBS/
13 January 1995, 13:00.
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Appendix C
Grids in DSS

C.A1 Identifying Grid Records in DSS

Grid records in DSS are named according to a naming convention that
differs slightly from the convention for time-series or paired-data records.
Grids represent data over a region instead of at a single location and one
grid record contains data for a single time interval or instantaneous value.
The naming convention assigns the six pathname parts as follows.

e A-part: Refers to the grid reference system. At present,
Gagelnterp supports the HRAP and SHG grid systems as well as
a UTM-based system that can be used outside the conterminous
USA. For examples of grid A parts, see below. See appendices
D, E and F for details of the grid systems.

¢ B-part: Contains the name of the region covered by the grid. For
radar grids, this could be the name of the NWS River Forecast
Center that produces the grid. For interpolated grids, this could
be the name of a watershed.

e C-part: Refers to the parameter represented by the grid.
Examples include PRECIP for precipitation, AIRTEMP for air
temperature, SWE for snow-water equivalent, and ELEVATION
for ground surface elevation.

e D-part: Contains the start time. This is the starting time of the
interval covered by the grid. The date and time are given
military-style (DDMMMYYYY for date and HHMM for time on a
twenty-four hour clock) and the date and time are separated by a
colon (:). All times for grids should be given as UTC. Midnight is
represented by 0000 if it is a starting time and 2400 if it is an
ending time.

¢ E-part: Contains the end time. This is the ending time of the
interval covered by the grid. The E part is blank for grids of
instantaneous values.

e F-part: Refers to the version of the data. The version identifies
the source of the data or otherwise distinguishes one set of grids
from another. Version labels include STAGEIII for NWS stage |l
radar products, and INTERPOLATED for grids produced by
Gagelnterp.

DSS Grid pathname examples:

The A part of “SHG” in the pathname below indicates a 2000-meter
cell size (the default) in the SHG system. The B part names the

Rogue River in Oregon as the geographic extent of the grid. The C,
D, and E parts indicate that the grid represents the accumulation of
precipitation over basin for the hour ending at 1900 UTC on May 3,
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C.2

2003. Although the Rogue basin is in Oregon, the grid follows the
convention of using UTC time to mark start and end times for grid
data. Finally, the F part indicates that this grid was generated by
Gagelnterp.

/SHG/ROGUE/PRECIP/03MAY2003:1800/03MAY2003:1900/GAGEINTERP/

The pathname below names a precipitation grid for the Missouri
River basin for the hour ending at 0100 UTC. The grid is produced
by the Missouri Basin River Forecast Center (MBRFC) and is a
product of the NWS’s multi-sensor precipitation estimate. It is stored
in HRAP grid system, as the MBRFC produces it.

/HRAP/MBRFC/PRECIP/22SEP2004:0000/22SEP2004:0100/MPE/

The pathname below names an HRAP grid representing a
Quantitative Precipitation Forecast over the Ohio River Basin. This
is a NWS product from the Ohio River RFC, and it covers the
twenty-four hour period from noon June 1, 2001 to noon June 2,
2001 (UTC).

/HRAP/OHRFC/PRECIP/01JUN2001:1200/02JUN2001:1200/QPF/
The pathname below names an SHG temperature grid for the
Rogue River basin. The cell size in this grid is 1000 meters instead
of the default 2000 meters for SHG. Because the temperature is an
instantaneous value at 0800, the E-part of the path is blank.
[SHG1K/ROGUE/AIRTEMP/22FEB2002:0800//GAGEINTERP/

<UTM example>

Contents of a Grid Record in DSS

Most HEC-DSS records, including time-series and grid records, consist of
an array of sequential data and an associated header describing the data
in the array. In a time-series record, the array represents the variation of a
parameter’s value through time at a fixed location. In a grid record, the
array represents the variation of a parameter’s value over a region of the
earth’s surface for a single time or interval of time. The header of a grid
record contains metadata for the parameter values (their units and some
summary statistics) and for the two-dimensional array in which the
parameter values are stored (the number of rows and columns in the
array, and the location of the grid in geo-referenced coordinates).

The contents of the header for four types of grid records in DSS are
described in section C.4 below. The UNDEFINED grid header type
contains basic parameter and grid extent information, common to all grid
types. The headers for HRAP grids and Albers equal-area grids (including
SHG grids) contain additional metadata and the specified reference
header type (used for UTM-based grids) contains a complete definition of
the spatial reference system of the grid.
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C3 Storage of Grid Values

In the DSS file, grid parameter values are stored in a single array, starting
with the value in the minimum-x, minimum-y (or lower left) cell in the two-
dimensional array. The values proceed by row in increasing column
numbers and increasing row numbers, as illustrated in Figure C.1.

71819

112314567819 4156
Array 1123

Grid

Figure C.1 One-Dimensional Array Storing Two-Dimensional Grid of
Parameter Values

The array of parameter values is always compressed before it is written to
a DSS file. Two compression methods are used. One is a run-length
encoding method, which replaces repeated zero and null values with the
number of times zero or null was repeated. The second method is the
deflate method, which is included in the zlib library described in RFC
1950. The deflate format itself is described in RFC 1951. The deflate
format and zlib are included in Javasoft's Java Development Kit version
1.1 and higher.

C4 Grid Header Contents

Table C.1a Grid Header Contents (All Types)

Size
Field Type (integers)
Info Flat Size Integer 1
Grid Type Integer 1
Grid Info Size Integer 1
Start Time Integer 1
End Time Integer 1
Data Units Text 3
Data Type Integer 1
Lower Left Cell X Integer 1
Lower Left Cell Y Integer 1
Number of Cells X Integer 1
Number of Cells Y Integer 1
Cell Size Float 1
Compression Method Integer 1
Compressed Array Size Integer 1
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Size
Field Type (integers)
Compression Scale Factor Float 1
Compression Base Float 1
Max Data Value Float 1
Min Data Value Float 1
Mean Data Value Float 1
Number of Ranges Integer 1
Range Limit Table Float 20
Range Counts Integer 20
Notes:

¢ Info Flat Size should represent the size (in bytes) of the header of
the grid record. This is somewhat implementation dependent and
results may vary.

e Grid Type is the integer representation of the DSS record type of
the grid. Grid types are numbered starting at 400, as follows.

O

O

O

400: Unknown grid type. Grid Info contains only the
common elements listed in table C.1a.

410: HRAP grid type. Grid Info contains common
elements and the HRAP data source. See table C.1b.
420: Albers grid type. Grid Info contains common
elements and Albers projection metadata. This is the type
used for SHG grids. See table C.1b.

430: Specified grid type. Grid Info contains common
elements and additional metadata including a general-
purpose definition of the spatial reference system. See
table C.1c.

In some applications, a non-time-varying grid is
incremented by adding 1 to the grid type, 411, for example
could be used as the grid type of an HRAP grid of some
fixed property, such as ground elevation. To date, use of
this convention has been inconsistent. Grid types ending
in 1 can safely be assumed to be time-invariant, but grid
types ending in 0 cannot always be assumed to be
members of a sequence of time-varying grids.

e Start Time and End Time are represented by an integer number of
minutes since 31 Dec 1899, 00:00. This number can be
converted to an HecTime using the set() method.

e Data Units is a string converted to Hollerith values. The three-
integer field can contain up to 12 characters.

e Data Type is one of the following.

o

O O O O O

0 = Period Average

1 = Period Cumulative

2 = Instantaneous Value

3 = Instantaneous Cumulative
4 = Frequency

5 = Invalid
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Lower Left Cell X and Y, and Number of Cells X and Y represent
the row and column number of the origin, and the extent in rows
and columns of the grid in the record, relative to the numbering
system implied by the grid reference system (HRAP, SHG, etc.).
Cell Size is a float value cast to an "int" data type for storage. It
represents the size, in meters, of a cell in the grid. Cells are
assumed to be square.
Compression Method:

o 0 =Undefined Compression Method

o 101001 = Precip 2 Byte

o 26 = Deflate using the ZLIB library function.
Compressed Array Size is the number of bytes used in the DSS
record to store the compressed array of grid values.
Compression Scale Factor and Compression Base are values
used for scaling the data in the array for storage. The base is
subtracted from each value and the result is divided by the scale
Factor. For precipitation in mm, the base is 0, and scale is 100,
so that 5.00mm of rain is represented in the stored array as 500.
Min Data Value, Max Data Value, and Mean Data Value apply to
non-null values in the array, with their conventional meanings.
Number of Ranges, Range Limit Table, and Range Counts
provide a data summary. The range count array contains, in
decreasing order, the counts of cells that are less than or equal to,
the range limit values stored in the range limit array (stored in
order of increasing value). The tables can contain up to 20
values. The default range array table contains 13 values (NULL,
0.0, 1E-7, 5.0, 10.0, 20.0, 50.0, 100.0, 200.0, 500.0, 1000.0,
2000.0, and 5000.0) which were set for precipitation values in mm
for durations on the order of an hour. Other ranges limits can be
set through the programming interface.

Table C.1b Grid Header Contents (Fixed Spatial Reference)

Size
Field Type (integers)
HRAP Headers append the following
Data Source | Text | 3
Albers Headers (including SHG) append the following
Projection Datum Integer 1
Projection Units Text 3
First Standard Parallel Float 1
Second Standard Parallel Float 1
Central Meridian Float 1
Latitude of Origin Float 1
False Easting Float 1
False Northing Float 1
X Coordinate of Cell (0,0) Float 1
Y Coordinate of Cell (0,0) Float 1
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Notes:
e Data Source field for HRAP headers can contain up to 12 ASCII
characters using Hollerith encoding.
e Projection Datum for Albers headers is one of the following:
o 0= Undefined Projection Datum
o 1=NAD 27
o 2=NAD 83
e Projection Units field for Albers headers can contain up to twelve
ASCII characters

Table C.1¢ Grid Header Contents (Specified Spatial Reference)

Size
Field Type (integers)
Specified Grid Info Headers append the following
Version Number Integer 1
SRS Name Length Integer 1
SRS Name Text As Specified
SRS Definition Type Integer 1
SRS Definition Length Integer 1
SRS Definition Text As Specified
X Coordinate of Cell (0,0) Float 1
Y Coordinate of Cell (0,0) Float 1
Null Value Float 1
Time Zone ID Length Int 1
Time Zone ID Text As Specified
Time Zone Raw Offset Integer 1
Is Interval Boolean 1
Is Time-Stamped Boolean 1

Notes:
e Version number is an integer. When a change in the stored
information occurs the number will be increased. No dots or sub-
versions will be used.
o The Length fields for SRS Name, SRS Definition, and Time Zone
ID specify the number of integers used to store the Hollerith-
encoded (four characters per "int") SRS Name, SRS Definition,
and Time Zone ID text fields.
e SRS Definition Type is one of the following:
o 0 =Well-Known Text (WKT)

e |s Interval and Is Time-Stamped fields are stored as integers.
o 0= False
o 1 =True (any non-zero value will convert to True.)
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Appendix D

HRAP Grid System

The Hydrologic Rainfall Analysis Project (HRAP) grid is a square-celled
map grid based on a Polar Stereographic map projection with the

following parameters.

Units: Meters

Datum: Sphere (radius = 6371.2 km)
Standard Parallel: 60° 0’ 0” North
Central Meridian: 105° 0’ 0” West

The mesh (cell) size of
the grid is 4.7625 km,
and the grid Y axis is
aligned parallel with the
central meridian

(105° W). The grid is
registered so that the
North Pole lies exactly

400 cells in the positive X

direction and 1600 cells

in the positive Y direction

from the grid origin.
Equivalently, the lower

left corner of cell number
(401, 1601) is located at

the North Pole.

Examples

Ix

As examples of cell identification in the HRAP system, indices of cells
containing points in the western US and the eastern US are given.

Western United States: The location 121° 45" west, 38° 35' north (near
Davis, California) projects to 260,174 m easting, 2,143,782 m northing, in
the specified polar stereographic projection. In the HRAP system the
indices of the cell containing this point are:

i =54
j =450
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Eastern United States: The location 76° 30" west, 42° 25' north (near
Ithaca, New York) projects to 4,410,804 m easting, 3,018,420 m northing,
in the specified polar stereographic projection. In the HRAP system the
indices of the cell containing this point are:

i =926
j =633
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Appendix E
SHG Grid System

The standard hydrologic grid (SHG) is a variable-resolution square-celled
map grid defined for the conterminous United States. The coordinate
system of the grid is based on the Albers equal-area conic map projection
with the following parameters.

Units: Meters

Datum: North American Datum, 1983 (NAD83)
lst Standard Parallel: 29° 30’ 0” North
2nd Standard Parallel: 45° 30’ 0” North
Central Meridian: 96° 0’ 0” West
Latitude of Origin: 23° 0’ 0” North
False Easting: 0.0

False Northing: 0.0

Users of the grid
can select a b iAEm.
resolution suitable EEEAN EERL L
for the scale and AR 5
scope of the study EERE ]

for which it is being =s== ] \
used. For general- 2 T ] P
purpose hydrologic H ‘7 R S CapLNRRR
modeling with ST r =
NEXRAD radar EaSeyE=S e H :
precipitation data, \EEE am
HEC recommends >
2000-meter cells, =i
and HEC computer

programs that use the SHG for calculation will select this cell size as a
default. HEC will also support the following grid resolutions: 10,000-
meter, 5,000-meter, 1,000-meter, 500-meter, 200-meter, 100-meter, fifty-
meter, twenty-meter, ten-meter. The grids resulting from the different
resolutions will be referred to as SHG two-kilometer, SHG one-kilometer,
SHG 500-meter and so on. A grid identified as SHG with no cell-size
indication will be assumed to have two-kilometer cells.

B P .|
ot

[
-
r—-TRﬁL_
I
|
I
1Y
|
T

‘[”'s\.
1
2|
q

For identification, each cell in the grid has a pair of integer indices (i, j)
indicating the position, by cell count, of its southwest (or minimum-x,
minimum-y) corner, relative to the grid’s origin at 96° W, 23° N. For
example the southwest corner of cell (121,346) in the SHG two-kilometer
grid is located at an Easting of 242000 meter and a northing of 692000

E-1



Appendix E — SHG Grid System Gagelnterp User's Manual

meter. To find the indices of the cell in which a point is located, find the
point’s easting and northing in the projected coordinate system defined
above, and calculates the indices with the following formulas.

i = floor( easting / cellsize )
j = floor( northing / cellsize )

Where floor(x) is the largest integer less than or equal to x.

Examples

As examples of cell identification in the SHG system, indices of cells
containing points in the western US and the eastern US will be given in
the one-kilometer, two-kilometer, and 500-meter SHG grids.

Western United States: The location 121° 45’ west, 38° 35 north
(near Davis, California) projects to -2195054 meter easting, 2027427
meter northing, in the specified Albers projection. In the SHG two-
kilometer system the indices of the cell containing this point are:

i = floor( -2195054 / 2000 ) = floor( -1097.5 ) = -1098
j = floor( 2027427 / 2000 ) = floor( 1013.7 ) = 1013

Eastern United States: The location 76° 30’ west, 42° 25' north
(near Ithaca, New York) projects to 1583489 meter easting, 2320553
meter northing, in the specified Albers projection. In the SHG two-
kilometer system the indices of the cell containing this point are:

i = floor(1583489 / 2000 ) = floor( 791.7 ) = 791
j = floor(2320553 / 2000 ) = floor( 1160.3) = 1160

In the SHG one-kilometer grid the indices are (1583, 2320), and in SHG
500-meter the indices are (3167, 4640).
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Appendix F

Standardized UTM Grid System

The HRAP and SHG systems are undefined outside the conterminous
US. To make practical applications of gridded computations in HEC-HMS
outside of the CONUS region easier, HEC has developed a grid system
based on UTM coordinates, using the cell-numbering conventions of
SHG. By selecting a UTM zone (including the selection of northern or
southern hemisphere) and cell size, a user can apply a grid system
anywhere that UTM coordinates can be used.

Units: Meters

Datum: World Geodetic System (WGS84)
Projected Coordinate System: Universal
Transverse Mercator (UTM)

zZones: 1-60, North(N) or South(S)

(Example: Island of Madagascar, UTM 38S,
cells are 100km square for illustration)

As with SHG, users of the grid can select a
resolution suitable for the scale and scope of the
study for which it is being used. HEC will support
the foIIowmg grid resolutions: 10,000-meter, 5,000-meter, 2,000-meter,
1,000-meter, 500-meter, 200-meter, 100-meter, fifty-meter, twenty-meter,
ten-meter.

For identification, each cell in the grid has a pair of integer indices (i, j)
indicating the position, by cell count, of its southwest (or minimum-x,
minimum-y) corner, relative to the UTM zone coordinate origin. For
example the southwest corner of cell (233, 4077) in a UTM two-kilometer
grid is located at an Easting of 466000 meters and a northing of 8154000
meters. To find the indices of the cell in which a point is located, find the
point’s easting and northing in the projected coordinate system defined
above, and calculates the indices with the following formulas.

i = floor( easting / cellsize )
j = floor( northing / cellsize )

where floor(x) is the largest integer less than or equal to x.

An Example

As examples of cell identification in a UTM spatial reference system,
indices of cells containing points on the west and east coasts will be given
in one-kilometer, two-kilometer, and 500-meter grids based on UTM zone
388S.
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West coast: The location 43° 15’ 25" east, 22° 3' 27" north (near the
westernmost point of the island) projects to 320132 meters easting,
755978 meters northing, in the UTM zone 38 south. In a two-kilometer
system the indices of the cell containing this point are:

i = floor( 320132/ 2000 ) = floor( 160.061 ) = 160
j = floor( 755978/ 2000 ) = floor( 377.989 ) = 377

In the one-kilometer grid the indices are (320, 755), and in the 500-meter
grid, the indices are (640, 1511).

East coast: The location 50° 31' 49" east, 15° 20' 11" south (near the
easternmost point of the island) projects to 449580 meters easting,
8304412 meters northing, in UTM zone 38 south. In a two-kilometer
system the indices of the cell containing this point are:

i = floor(449580/ 2000 ) = floor( 224.79) = 224
j = floor(8304412/ 2000 ) = floor(4152.206 ) = 4152

In the one-kilometer grid the indices are (449, 8304), and in the 500-
meter grid, the indices are (899, 16608).

Note that a point at this longitude and latitude falls within the bounds of
UTM zone 39 south. However, for this example it is assumed that one
grid is being produced for precipitation over the whole island, so the
coordinates are calculated for the westernmost zone (38 south) within the
bounds of the grid.
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Appendix G

Grid Import and Export Utilities

Gagelnterp requires that parameter grids like elevation grids for
temperature lapse computations and pattern grids for precipitation bias
computations must be stored as DSS grid records in the same grid
system as the output grid. A GIS program with that supports raster data,
like Arcinfo® or GeoMedia®, is generally required to create such grids,
but those programs do not support DSS grids as a data format. Two
utility programs are available to bridge the gap between raster GIS and
grids in DSS through the use on an intermediate ASCI|I text file.

The programs are named asc2dssGridand dss2ascGrid, and can be
run from a Windows or UNIX command line or can be incorporated into
scripts for integration between DSS and GIS programs.

The intermediate ASCII file is formatted for compatibility with the Arcinfo®
ASCIIGRID command. The files consist of a six-line header followed by
an array of values laid out like an image of the grid. The six header lines

are:
NCOLS <number of grid columns (integer)>
NROWS <number of grid columns (integer)>
XLLCORNER <Lower-Left X Coordinate (real)>
YLLCORNER <Lower-Left Y Coordinate (real)>
CELLSIZE <Cell size (real)>
NODATA_VALUE <Value that indicates null cell>

The NODATA value defaults to -9999.

G.1 Importing grids to DSS with asc2dssGrid

The asc2dssGrid utility takes the following arguments

INPUT=<name of ASCII input file>
DSS=<name of DSS file>
PATH=<complete DSS path name>
GRIDTYPE=<HRAP, SHG, or UTM>
ZONE=<UTM zone identifier>
DUNITS=<data units>
DTYPE=<data type>

The arguments can be given in any order. The DUNITS and DTYPE
arguments are optional. The imported grid’s units default to mm if
DUNITS is absent. If the PATH argument contains valid times in both the
D and E parts, the imported grid’s data type will default to PER-CUM. If
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the E part (end time) is blank, the data type will default to INST-VAL. If
the GRIDTYPE argument is absent, the grid type will be read from the A
part of the path argument.

For example, the command:

asc2dssGrid in=grid.asc dss=mydss.dss
path=/HRAP/TEST/PRECIP/23JUN2003:0100/23JUN2003:0200/IMPORT/

will treat the contents of the ASCII file grid. asc as though they were
PER-CUM precipitation data reported in millimeter, and create an HRAP
grid record with the given path in the given DSS file.

The program has some simple checks for data errors, such as missing
files, unsupported data types, and unsupported cell sizes. It does not
check for unsupported unit names or unreasonable data values.

The following command could be used to import an elevation grid for
lapse computations.

asc2dssGrid in=elev.asc dss=mydss.dss DTYPE=INST-VAL
DUNITS=METERS path=/SHG/ROGUE/ELEVATION///IMPORT/

G.2 Exporting grids from DSS with dss2ascGrid

The dss2ascGrid utility takes the following arguments:

OUTPUT=<name of ASCII output file>
DSS=<name of DSS file>
PATH=<complete DSS path name>
PRECISION=<number of decimal places>

The arguments can be given in any order. The following command will
write the contents of a DSS grid record to an ASCII text file, which can be
imported directly into Arcinfo®.

dssZascGrid OUTPUT=precip grid.asc dss=mydss.dss PREC=2
path=/HRAP/TEST/PRECIP/23JUN2003:0100/23JUN2003:0200/IMPORT/

The text file may need additional modification before it can be imported to
other GIS or surface analysis programs.
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Appendix H

Using ArcGIS® to Build an Elevation
Grid in DSS

In order to adjust temperature grids by lapse, Gagelnterp needs an
elevation grid that covers the same region as the grids that will be
computed. The elevation grid should be in the same grid system and
have the same cell size as the output grids. The ArcGIS® procedure
outlined below was used to produce an elevation grid in DSS starting
from USGS DEMs.

This procedure worked in ArcGIS version 10.2. Updates to ArcGIS may
change the function names or user interface components required to
carry out these steps. These steps do not require Arcinfo® or ArcEditor®
features (that is, it can be done with ArcView®) but it does require the
Spatial Analyst® extension for grid operations.

1. If you don’t have one already, create an ArcGIS® map (.mxd) for
the watershed.

2. Create a data frame in the map with a coordinate system that
matches the grid system (SHG or HRAP) you'll be using for your
temperature grids. See Appendices D and E for coordinate system
details.

3. Add an elevation grid to the data frame. This can be the DEM used
for analysis in GeoHMS, or an elevation grid imported from the
National Elevation Dataset (NED). Make sure that the elevations
are given in either feet or meters and that you know which of those
are used in the grid.

4. If you have them, add the GeoHMS themes that represent the
watershed extent and stream network to the data frame. These
won'’t be used in the analysis, but they are very helpful for making
sure that your data covers the entire basin.

5. Project the DEM into your target coordinate system (SHG or
HRAP) using the “Project Raster” tool in the Arc Toolbox under
Data Management Tools => Projections and Transformations =>
Raster => Project Raster. (See figure. Note that the 40 m cell size
and the optional Registration Point position of (0, 0) bring the DEM
into tidy alignment with the SHG.)

6. From the HMS model’s grid cell file, determine the minimum and
maximum cell row and column numbers. You can load the file into
a spreadsheet program or use the UNIX sort command to do this.
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,
:

Input Raster Registration Point |
merged elevations j (optional)
Input Coordinate System (optional)

GCS_North_American_1983 The x and y coordinates (in |
= = = the output space) used for
Output Raster Dataset pixel alignment.

C:\Users\gOhectae\Documents'gis_data\american\DEMYmerged_albers
The registration point works
similar to the concept of
snap raster. Instead of
Geographic Transformation (optional) snapping the output to an
existing raster cell
alignment, the registration
point allows you to specify
the origin point for
anchoring the output cells.
All output cells will be an
interval of the cell size
away from this point. This
point does not have to be a
corner coordinate or fall
within the raster dataset.

Qutput Coordinate System
UsA_Contiguous_albers_Equal_Area_Conic_USGS_version

@ @

«| 3] [x] [+

Resampling Technigue (optional) The Snap Raster

(| EILINEAR - environment setting will

Output Cell Size {optional) take priority over the

.] Registration Paint
parameter. Therefore, if you

X Y want to set the registration

40.000000 40.000000 point, make sure that Snap
Raster is not set.

(1 Registration Point {optional)
X Coordinate ¥ Coordinate

H [ Ok ] [ Cancel ] [Enwronmems.” ] [ << Hide Help ] [ Tool Help ]

r=

Multiply the row and column numbers by the cell size to convert
them to coordinate values. (Add one cell to the maximum row and
column numbers before multiplying to cover the entire area of the

grid.).

Select the "Aggregate" tool from the Spatial Analyst Tools =>
Generalization toolbox. Select your projected elevation grid as the
input raster. Choose a cell factor that will produce your SHG cell
size. (See figure, where we’re using a region of 50 by 50 40-meter
cells to produce a 2-km grid.) Select "median" as the overlay
statistic (use mean if you prefer it to median) and select the
location where the grid will be stored.

—— o5 [ |

-

Aggregate

Input raster

‘merged_alhers ﬂ
EilmiEEs Genera_tes a reduced-
> resolution version of a
C:\Users\ghectae \Documentslgis_data\american\DEMdem_alb_2k raster. Each output cell
Cell factor contains the Sum,
50 Minimum, Maximum,

Mean, or Median of the
input cells that are
encompassed by the
Expand extent f needed (optional) extent of that cell.

Aggregation technique {optional)
MEDIAM -

| Ignare MNoData in calculations (optional)

[ OK ] [ Cancel ] [Enviranmems‘.. ] [ << Hide Help ] [ Tool Help
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Click the "Environments..." button and expand the “Processing
Extent” field. Fill in values for the processing extent to match edges

of SHG cells at your cell size. (For two-km cells,

the edge

coordinates should end in even numbers followed by three zeroes.)

———
Environment Settings

S

¥ Workspace
¥ Output Coordinates

# Processing Extent
Extent

As Specified Below V] @
Top
2185000.,000000
Left Right
-2234000.000000 -1925000.000000

Bottom
1904000.000000

Snap Raster

ai=
¥ XY Resolution and Tolerance

¥ M values

¥ Z Values -

Extent

m

The Output Extent
environment setting defines
what features or rasters will
be processed by a tool.

This setting is useful when
you need to process only a
portion of a larger dataset.
You can think of this

setting as a rectangle used
to select input features and
rasters for processing. Any
feature or raster that

passes through the

rectangle will be processed
and written to output. Mote
that the rectangle is used i
only to select features, not |
clip them. The extent of the

g

” Cancel H << Hide Help ]

[ Tooltep |

Press “OK” to close the environments dialog and “OK” to launch

the aggregation computation.

Your data frame should now include a grid of representative
elevations at the same resolution and in the same coordinate
system as the temperature grids you will compute in Gagelnterp.
The result should look something like the figure below.

@ DEMAAmerican.md - ArcMap

Editorv | » Ll
Drawing~ K 5 % [ - A - 7| @) Al

COLGATEPOWERHOUSE. I
READERRANGH(CDF)
i

&« 157

LRI, B el =

© 57 DEM toSHG
= B NCRFC_Precip_Gages
B

FEATHER-YUBACITY.
VARYSVILLE(ASOSPEALEATS GRASSVALLEY
B

@ @ hue
=@

alue
| High: 34085

Low: 431768

LNCOLN(CDF)
.

UNIONHOUSECKNR ALPINEFROS TORELKGROVE

ELKGROVE COSUMNES-MICHIGANBAR

COSUMNES-WILTONRDERIDGE
B JFIDDLETOWN

HERALD
MOKELUMNE-BENSOIFERRY \T 210N (GDF INEG ROV
.

@aizn « ]

STIGERCREEKF

-2138.987 2097868 Kilometers
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9.

10.

Use the Raster to ASCII tool (Conversion Tools => From Raster =>
Raster to ASCII) to convert this coarse DEM to a text file for import
to DSS.

"\Q Raster to ASCI ‘ - o
Input raster " | Output ASCII raster
[dem_alb_2k =] file
Output ASCII raster file

C:\Users\gOhectae\Documents\gis_data\american\DEM\ 2kdem . ASC The output ASCII raster file.

I oK I l Cancel I lEnvironmenis‘.. I l << Hide Help I l Tool Help I

The header of the ASCII file should look something like this

ncols 153
nrows 141
x1llcorner -2234000
yllcorner 1904000
cellsize 2000

NODATA value -9999

Note the 2000 m cell size and that the X and Y coordinates of the
origin position is an exact multiple of the cell size.

Create a DSS grid record of the elevations by running
asc2dssGrid on the ASCII file you created. Be sure to set the
units correctly. Gagelnterp assumes that all elevation grids are in
meters unless the units field in the grid header is "ft" or "feet"
(spelled in upper or lower case)
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